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Student Affairs to Establish Development Initiatives 
 By Stefanie Landsman 
 
The world of fundraising is an area often overlooked by professionals in student 
affairs. While the main source of funding for programs comes from 
departmental budgets, great potential is present in an area that most offices 
overlook – foundation work. While the thought of seeking out donors and 
properly asking for large donations is not common within student affairs, a 
trend in establishing a student affairs development officer is currently on the 
rise.  
 
Universities across the country such as the University of North Carolina at 
Chapel Hill, the University of California at Berkeley, and the University of 
Illinois at Urbana Champaign are tapping into the potential of alumni donors 
within the realm of student affairs. Programs such as these have established 
student affairs development officers who work in collaboration with both the 
division of student affairs and their institution’s advancement office. Often 
times graduates may not feel a connection with their graduating class or their 
academic department, but fondly recall their time spent with a specific club or 
organization. Many of these individuals also attribute their professional 
successes to skills they acquired while serving on the executive boards of 
organizations such as SUBOG or participating as student athletes on club teams 
such as lacrosse.  
 
Currently, the UConn Foundation has major gift officers within the majority of 
academic colleges. These individuals are responsible for targeting potential 
donors who graduated from their respective colleges in hopes that they want to 
give back to the department that helped establish them as a professional. 
Unfortunately, this does not take into account the out-of-classroom learning 
environment. This leaves UConn with great potential to tap into individuals 
who were once engaged in co-curricular activities.  
 
Independent consultant, Dr. Eileen Sullivan, was brought to campus by Dr. 
John Saddlemire to assess the potential for establishing a student affairs 
development officer here at UConn. She spent the day speaking with 
professionals from both student affairs and institutional advancement in order to 
gauge the interest in, and support for, establishing this type of initiative within 
the Division. The feedback she received was then used to create a list of 
recommendations that the Division should take into consideration as they begin 
to create an environment that this type of development work can flourish in. 
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When put in place, this initiative will benefit all facets of the Division. Similar 
to the major gift that was recently received to establish the Leadership Legacy 
Program, the donations that result will not only provide budget relief, but will 
also enable the institution to grow its endowment by providing support for 
additional programs and services. Currently, the proposal is in its early phase 
and is focused on obtaining the names and levels of involvement of alumni, 
ranging from past community assistants, to members of USG, to members of 
club sports teams. After this information is collected and properly tagged, we 
will then work with the Foundation to undergo wealth capacity screenings and 
begin to cultivate relationships with these prospective donors. 
 
Creating the infrastructure to carry out this initiative is no easy task, but with 
the collaboration of everyone within the Division, as well as a strong 
partnership with the UConn Foundation, it will yield great success for the 
Division and overall UConn community. 
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Committee Updates  
 

Strategic Planning Committee by Nancy Bilmes and John Sears 
 
The Strategic Planning Committee continues to work diligently toward the 
Division’s next three-year planning cycle.  Of note, John Saddlemire, Vice 
President for Student Affairs, recently attended and addressed the full 
committee on December 1st.  Dr. Saddlemire outlined to the committee several 
University initiatives that impact the Division and its planning process.  He also 
commented about his vision for the future.  Questions and discussion followed 
Dr. Saddlemire’s comments. 
 
The Committee continues to conduct its business via three sub-committees: 
Critical Issues, Division Retreat, and Division Initiatives. As always, the 
Strategic Planning Committee seeks feedback and comments from all Division 
staff regarding the future of the Division.  Contact your committee 
representative or visit the committee webpage for more information and links to 
pass along comments: 
http://www.studentaffairs.uconn.edu/committees_saplan.html 

Scoring the Division Report Card on Strategic 
Planning and Critical Issues  
 
As you know, the Strategic Planning Committee has recently adopted a sub-
committee framework for conducting the business of the committee. The 
Division Retreat sub-committee will be hosting a focus group on January 10, 
2007, following the Division breakfast. We will be inviting representatives 
from across the Division to participate in the day’s events. The overall goal of 
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this focus group is to revisit the current strategic plan and critical issues, as well 
as examine future trends that will affect the way in which we do our jobs. 
Through a reflective process, the focus group will aim to collect qualitative 
information which will help guide the new iteration of the strategic plan.  If you 
are interested in participating in the focus group, or if you are looking for more 
information, please feel free to email one of the sub-committee co-chairs: 
Christine Morello christine.morello@uconn.edu or Mary Ann Ives 
mary.ives@uconn.edu. 

Staff Activities 
 

David Clokey, Assistant Vice President for Student Affairs: 
 
John Saddlemire, Vice President for Student Affairs, is pleased to announce that 
David Clokey’s title is now Assistant Vice President for Student Affairs.  Mr. 
Clokey’s former title, Executive Director of Finance and Technology, did not 
fully reflect the growing scope of his duties.  This summer, David took on the 
additional role of Student Union supervision. Please join the Vice President’s 
office in congratulating Mr. Clokey as his service and role within the Division 
is formally acknowledged. 
 
Tom Szigethy, Director of the Office of Alcohol and Other Drug Services: 
 
Tom Szigethy, MA; Sherry Bassi, Ph.D; and Master Sergeant, Linda Killarney 
will be presenting "Community Coalitions Effecting Environmental Change of 
the Substance Use Culture on Campus" at the 2007 joint ACPA/NASPA 
convention in Orlando, FL. 
 
Megan Wildenstein, Graduate Assistant, Student Activities: 
 
Megan was one of ten graduate student applicants selected to be a National 
Association for Campus Activities (NACA) Graduate Intern in Nashville, TN at 
the National Convention.  The goal of the internship program is to provide an 
educational professional development experience through volunteer work, co-
presenting an educational session, and to provide financial assistance 
(registration waived) to graduate students who attend the Convention. 

A Day in the Life of a Software Application 
Developer… 
 

8:30 am: Read and respond to emails. 
  
8:50 am: Coffee/tea is essential to the developer's proper functioning. 
  
9:00 am: Check for new issues or problems. In our lingo, it is called "looking at 
our ticket queue."  We respond to requestors, resolve as many issues as 
possible, and contact requestors with resolutions. Sometimes, it will take more 
time and research. If facing a problem, surf the web to find information on a 
problem or talk with fellow developers or someone from the web team or 
sysadmin team. It all depends who can help! 
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12:00pm: Lunch… We may linger in front of our favorite screen and browse 
the news while eating lunch. Some of us go and meet a friend or a colleague for 
lunch. Some others go exercise. 
  
1:00 pm: Afternoon is project time! It depends where we are in a project. If it's 
the beginning of a project, it is the design phase. We spend a lot of time 
meeting with the whole team and with our users. We talk about the 
functionality of the application, making sure that we understand what's needed. 
It is really important to get feedback from our users. We design "pretend" 
screen shots to show them what the application will do and we generate 
"design" documents for our own understanding. 
  
Once the design is done, it is the second phase: Coding. This means fewer 
meetings and lots of time coding alone or with a fellow developer. For obvious 
reasons, that should not last longer than two weeks at a time! 
  
When the coding period is done, there's testing and feedback from the users. We 
may need to tweak some things (we call that bug fixing). Then the application is 
ready to be used and we celebrate! 
  
Don't forget coffee or tea for survival. Some even rely on chocolate in the 
afternoons. 

4:30 pm - ?: We should go home but there's always that last thing that we want 
to finish "because it makes sense." 

New Staff Introductions 
 

The Student Union is pleased to announce that Ms. Jennifer Navarro has been 
hired as the newest member of the Student Union Reservations team.  She has 
been living in this area since 1979 and graduated from E.O. Smith many moons 
ago.  She currently lives in South Windham with her husband, and three 
children (two daughters 19 and 15, and a son 12).  She spends a lot of her time 
outdoors fishing, walking, kayaking, gardening, or playing with her dogs.  She 
enjoys cooking, movies, and spending time with friends and family. As a 
teenager, she worked for Dining Services and Residential Life.  She has worked 
at the University of Connecticut full time since 1998, beginning with the School 
of Business Center for Healthcare & Insurance Studies, then the Undergraduate 
Admissions Office. 
 
Ms. Fran Boucher started here at UConn in the Catering Department.  She then 
supervised the Union Café and recently moved to the Chem Café.  Fran and her 
husband, Chris live in Ashford along with their daughter Shelli, who is a third 
year chemistry/pre-dental student here at UConn.  Fran started as a third shift 
Custodian on Friday, November 24th. 

World AIDS Week Awareness 
 
During this year's World AIDS Week Health Education's peer education group, 
the Sexperts, raised about $800 for the Hole in the Wall Connecticut and 
Florida camps for their HIV+ week.  Instead of pledging money for a walk-a-
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thon, for each dollar we had raised in the weeks before the event, we hoped to 
teach a safer sex skill to a UConn student. To do so, Health Education decided 
to host a condom-a-thon during Husky Howl on World AIDS Day, December 
1.  Over 200 students participated by practicing a safer sex technique - how to 
put a condom on correctly or cut a condom into a dental dam.  Students 
received an ice cream sundae in return.  Though we were unable to teach a safer 
sex skill for each of the $800 dollars we raised (a lofty goal), we found that 
many students were interested in learning a safer sex skill.  For some, this was a 
newly acquired skill.  We were excited about the donations raised, the turnout, 
and feel that this event was very successful for all! 

SAIT “Tips & Tricks” 
    

How do I share a document with someone who doesn't have my version of 
Word? 

1. Choose Save As from the File menu.  
2. In the Save as type box, select the file type you want to use.  

If you're not sure what file type will work (such as when you are sending a 
document to someone else) choose Rich Text Format (*.rtf)  or WordPerfect 
5.1 for DOS (*.doc). All recent word processing programs for Windows or 
Macintosh can read either of these formats. However, the conversion is 
sometimes not perfect and any formatting Word cannot convert will be 
discarded. 
  
How do I number pages in Word?  

1. Choose Page Numbers from the Insert menu.  
2. In the dialog box, select the Position and Alignment for your page 

numbers. The Format button allows you to choose different number 
formats, as well as control the page numbers in documents with multiple 
sections.  

How can I diagnose formatting problems in Word?  

You can use the Show/Hide button ¶ on the Standard toolbar to display 
paragraph marks, spaces, tabs, and other normally invisible characters that are 
embedded in the text. To diagnose a paragraph formatting problem, click in the 
paragraph that is in question, then choose Paragraph from the Format menu to 
see all of the settings applied in that paragraph. If you select multiple 
paragraphs, then select the Paragraph command, the settings that are not the 
same in each selected paragraph will be blank. 

Professional Association Websites 

Have you ever been curious about the different professional associations 
available? Listed below are a few of the larger organizations within different 
functional areas. If you are familiar with an organization that is not listed 
below, please send the relevant information to stefanie.landsman@uconn.edu 
so others in the Division can learn about another great resource to use. 
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American Counseling Association – www.counseling.org  
Membership link and information about how to join: 
http://www.counseling.org/AM/Template.cfm?Section=JOIN_RENEW 

American College Personnel Association – www.myacpa.org 
Membership link and information about how to join: 
http://members.myacpa.org/Scripts/4Disapi.dll/4DCGI/acpajoin/intro.html?Acti
on=join 

National Association of Student Personnel Administrators – www.naspa.org 
Membership link and information about how to join: 
http://www.naspa.org/membership/index.cfm?show=how 
 
American Psychological Association – www.apa.org  
Membership link and information about how to join: 
http://www.apa.org/membership/students.html  

Employment Opportunities Within the Division  
 
Opportunities for employment within the Division of Student Affairs are posted 
on the Division’s website at www.dsa.uconn.edu.  The most recent postings 
include: 
 

� Dining Services, Area Assistant Manager/Staff Trainer posted 
11.02.06 

� Dining Services, Area Assistant Manager posted 11.02.06 

� Residence Hall Complex Manager posted 10.27.06 

� Director of Off-Campus Student Services posted 10.26.06 

� Administrative Services Specialist posted 10.20.06 

Keep checking the Division’s website and UConn HR for the most updated 
listings. 

Brick of the Week Awards  
 
Nominations 
Brick of the Week nominations are continuing to 
trickle in.  In order to make this an easier and 
more streamlined process, the Brick Committee would like to ask that 
nominations include the following: 
 

1. Name, department, and campus address of the person nominated.  This 
will ensure that their brick is delivered in an accurate and timely 
fashion. 

2. Include what Guiding Principle(s) they demonstrated and how they 
demonstrated it in just a few sentences.  These comments will be 
included in their award letter that accompanies their brick.   

 
All nominators will remain anonymous unless they choose to inform the 
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recipient.  The Division’s Guiding Principles can be found on page five of this 
newsletter and on the Strategic Planning Task Force website at 
http://www.committees.sa.uconn.edu/saplan/.   Please email Stefanie Landsman 
at stefanie.landsman@uconn.edu to nominate someone for a Brick of the 
Week award, or if you have any questions about the nomination process.   
 
Brick Recipients 
Please refer to the sidebars on pages 9-10 to see the individuals who have been 
recognized as making contributions to both the Division and UConn by their 
peers. 

Division-Wide Events & Announcements 
 
Division-Wide Breakfast 

Please join your colleagues for a hot breakfast at the annual Student Affairs 
Division-Wide Breakfast on Wednesday, January 10th, 2007 in the Rome 
Commons Ballroom. Registration/breakfast is from 8:00 – 8:45 AM and the 
program runs from 8:45 – 9:30 AM. Please RSVP to 486-2265 by January 3rd, 
2007.  

Additional Photos from Around the Division 
 
These photos were taken by the Division photographer, Michael Stenta, during 
the Midnight Breakfast on Sunday, December 10th, 2006. 
 
 
 
 
 
 

����

����

����

����

����

����

����

����

����

����

����

����

����

����

����

����

����

����

����

����

����

����

����

����

����

����

����

''' ' �/$�'$��/$�'$��/$�'$��/$�'$� """"/��*��$"�//��*��$"�//��*��$"�//��*��$"�/ ����
(���
���
,����'���
�
���
�

�����
����
%
� ��
�+�
���
�
�����
	
��
�
���������

0������'�����5������)��(��
�9����

+%��
7�:���9:�������

��?7�:���9:����D9��

0
�7�%

�7KK...�����������
���

�



������������	
��
�
������������
���������������
��� 
�	
����
����	
��
�
������
�� 8 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

���������	

���
����������� �
�����	��	
�����
����

������

��
		���������� !�����
�

"
�#�$�%��!�%�!�����
�&&$�%��!�%�!�����
'()$�%��!�%�!�����

�
*��+$,,---.#�
.�#
��.�
�,�

�
�

��� ��� ��� ��� ��� ��� ������ ��� ��� ���			 ��� 


 ��� ��� ��� ��� ��� ���


 ��� ��� ��� ������ ��� ��� ��� ��� ��� ��� ��� ��� ��� ��� ��� ���

�����������	�
�� �
�	/
�/���(�����/���

�
��
���	����	��� �
(�����/���&�	�#�
	�

�	��� �	������� �
(��
#�/���&�	�#�
	�

������ ��� ����	� �
&�	�#�
	�

��� 	�����
 �
0	
�	/��(�����/���

�



������������	
��
�
������������
���������������
��� 
�	
����
����	
��
�
������
�� 9 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

���
����(11/�	��2�1
	�/��
����#*�
�
�3�
4#4/*
���
��
����4/���'�

	�

�����5�����
���
/
�
��
		���������� !���%�

�
0*
��$�%��!�%�!�66 �

�
�

*��+$,,---.�/��.�#
��.�
�,�
�

�	��
������
��� �
7�/
�(++��#/��
����
�����/���

��������� �
&�	�#�
	�

�������	��� �
7�/
��3������(
������	/�
	�

��������	
 �
�3������(
������	/�
	�

�
��
�����
	� �
��#*��#/����++
	��4/�/��	�

���	
� �
����  �	��!��� �
�3������(
������	/�
	�

������"���� �
��#	��/	3�

"#	����$�!����	 �
7�/
���������4/�/��	�

			 ��� 


 ��� ��� ��� ��� ������ ��� ��� ��� ��� ��� ��� ������
��� ��� ��� ��� ��� ��� ��� ��� ��� ��� ��� ������ ��� ��� ��� ��� ��� ��� ��� ��� ��� ���������

$��	��	�%���	�  ���
	� �
7�/
�(++��#/��
���&�8��
+�	�



������������	
��
�
������������
���������������
��� 
�	
����
����	
��
�
������
�� 10 

 

���
����(11/�	��2�1
	�/��
����#*�
�
�3�
4#4/*
���
��
����4/���'�

	�

�����5�����
���
/
�
��
		���������� !���%�

�
0*
��$�%��!�%�!�66 �

�
�

*��+$,,---.�/��.�#
��.�
�,�
�

&	��	��%����	� �
��#*��#/����++
	���
�����/���

��'	��	����! �
(++��#/��
���&�8��
+�	�

����
	(��	
� ����
 �
(++��#/��
���&�8��
+�	�

%�����)�����'������ �
���
������++
	���

	
��/�
	�

&�������'�
 �
��������4/�/��	�

�	�
����*��� �
(++��#/��
����
�����/���

��#���+���	� �
(++��#/��
����
�����/���

��
��)���
 �
��������4/�/��	�

			 ��� 


 ��� ��� ��� ��� ������ ��� ��� ��� ��� ��� ��� ������
��� ��� ��� ��� ��� ��� ��� ��� ��� ��� ��� ������ ��� ��� ��� ��� ��� ��� ��� ��� ��� � ��������� ���������

���
	���	��		' �
(++��#/��
���&�8��
+�	�


